PEMERINTAH KABUPATEN MADIUN
DINAS PENANAMAN MODAL

DAN PELAYANAN TERPADU SATU PINTU
Website: www.dpmptsp.madiunkab.go.id e-mail: dpmptsp@madiunkab.go.id
J1. Aloon — Aloon Utara No. 04 Telp. (0351) 497206
MADIUN 63121

SURAT PERINTAH TUGAS
Nomor : 094/ 5g4 / 402.106/2020

Dasar : 1. Keputusan Menteri Pendayagunaan Aparatur Negara Nomor:
66/KEP/M.PAN/7/2003 Tanggal 17 Juli 2003 tentang Jabatan
Fungsional Pranata Komputer dan Angka Kreditnya;

2. Surat Rekomendasi Kepala Badan Pusat Statistik Nomor:
2402/REK/INP.PK/2018 Tanggal 08 Oktober 2018 tentang
Penyesuaian/Inpassing Dalam Jabatan Fungsional Pranata
Komputer;

3. Keputusan Bupati Madiun Nomor: 188.45/75/KPTS/402.013/2019
Tanggal 13 Maret 2019 tentang Pengangkatan Pegawai Negeri Sipil
dalam Jabatan Fungsional Pranata Komputer dan Angka Kreditnya
melalui Penyesuaian/Inpassing.

MEMERINTAHKAN
Kepada : Nama : Pancoro Pamungkas, ST
Pangkat/Gol : Penata (III/c)
NIP : 19811202 200902 1 006
Jabatan : Pranata Komputer Ahli Muda

Waktu Pelaksanaan : Kamis, 14 Mei 2020

Untuk : Melakukan Uji Coba Perangkat Lunak Baru KeePass 2.45
dan Memberikan Saran-saran Penggunaannya.

Ditetapkan di : Madiun
pada tanggal : (4 Mei 2020

KEPALA-DINAS PENANAMAN MODAL
DM@‘F@LA’Y- NAN TERPADU SATU PINTU

1Y

!gKRISDIANANTO S.STP
' Pembina Tingkat I
NIP. 19750925 199602 1 003




BUKTI FISIK KEGIATAN PRANATA KOMPUTER Halaman : 1 dari 7
AHLI
Nama PPK Pancoro Pamungkas, S.T. | Tanggal dibuat (4 Mei 2020
NIP 198112022009021006 Batasan Satu kali untuk
Pangkat/Golongan Penata/ lli/c Dinas Penanaman Modal | setiap perangkat
Jabatan Fungsional | Pranata Komputer Muda | dan Pelayanan Terpadu lunak baru
JENIS KEGIATAN : Satu Pintu
Kabupaten Madiun

MELAKUKAN UJI COBA PERANGKAT LUNAK BARU DAN MEMBERIKAN SARAN-SARAN

PENGGUNAANNYA
SPESIFIKASI :
Eksplorasi Perangkat Lunak KeePass 2.45 release 07 Mei 2020.
Deskripsi:

Pada era digital saat ini para pengguna komputer dan gadget berhubungan dengan berbagai aplikasi
yang membutuhkan username dan password untuk mengaksesnya. Semakin banyak aplikasi yang
digunakan, semakin banyak pula username dan password yang harus diingat atau dicatat.

KeePass adalah sebuah perangkat lunak yang dikembangkan Dominik Reichl untuk menyimpan
daftar username dan password, mengamankan semua data tersebut dengan sebuah password utama
(berupa master key yang diingat pengguna atau sebuah key file yang diamankan pengguna).

Spesifikasi:

— Perangkat lunak password manager open source (OS| Certified), berlisensi GNU General Public
License versi 2 keatas dan dibangun untuk sistem operasi Windows;

- Tersedia dalam pilihan installer (3 MB) atau portable (5,4 MB) untuk digunakan melalui USB
Flash Disk atau external storage lainnya;

— Database yang menyimpan username dan password menggunakan enkripsi AES-256,
ChaCha20 dan Twofish;

- Menyediakan sejumlah opsi yang mengakomodasi kebutuhan pengguna dalam password
management, antara lain melakukan impor data dari perangkat lunak penyimpan password lain,
pengaturan waktu untuk mengganti password secara berkala, mengelompokkan daftar password
dalam kelompok (group) tertentu dan sebagainya.

PELAKSANAAN DAN HASIL UJI COBA :

Lihat Halaman 2 sampai 7

SARAN-SARAN PENGGUNAAN :

- KeePass disarankan untuk diinstal pada komputer yang digunakan secara perorangan atau
cukup dijalankan (versi portable) melalui media USB Flash Disk khusus (atau external storage
lain) yang tidak dipinjamkan (berpindah tangan);

— Untuk keamanan dan kemudahan, gunakan KeePass portable yang dikompres (*.rar atau * zip)
dan diberikan password untuk mengurangi resiko terinfeksi malware atau berusaha diakses oleh
pihak-pihak yang tidak berhak.

KETERANGAN LAIN :

KeePass versi 2.45 merupakan perangkat lunak password manager yang sangat bermanfaat bagi
para pegawai yang sering berhubungan dengan berbagai aplikasi dan harus mengingat atau
mencatat banyak username dan password khususnya di lingkungan Dinas Penanaman Modal dan
Pelayanan Terpadu Satu Pintu Kabupaten Madiun.

Mengetahui, Madiun, [4 Mei 2020
Kepala Dinas Penanaman Modal Pejabat Pranata Komputer

dan Pelayanan Terpadu Satu Pintu

/..~ {Kabupaten Madiun
f ] - I

Pancoro Pamungkas, S.T.
NIP. 198112022009021006
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TANGGAL PELAKSANAAN UJI COBA
Uji coba dilaksanakan pada hari Kamis, tanggal 14 Mei 2020.

METODE UJI COBA

Metode uji coba yang dilakukan adalah Black Box Testing KeePass 2.45 dengan cara mengeksplorasi

dan menguji fungsi-fungsi yang disediakan.

Adapun langkah-langkahnya adalah sebagai berikut:

1. Download KeePass 2.45 dari URL https://keepass.info/. Pilih versi yang dibutuhkan, installer atau

portable;

2. Saat pertama dijalankan, KeePass akan meminta pengguna untuk membuat database baru yang
kelak difungsikan untuk memuat data password, sekaligus membuat password utama untuk
mengakses database KeePass. Pilih File > New ... untuk memulai proses;

KeePass =
File  Group Entry Find View Tools Help
[ & [ |<E-| 3~ 2 | iy ”
KeePass Hees

@ New Database

Your data will be stored in a KeePass database file, which
is a regular file. After clicking [OK], you will be prompted
to specify the location where KeePass should save this
file.

It is important that you rermember where the database
file is stored,

You should reqularly create a backup of the database file
{onto an independent data storage device),

0K | | Cancel

0 of 0 selected | Ready.

3. KeePass 2.45 menyediakan tiga pilihan untuk mengakses data yang disimpan didalamnya, yaitu:
a. Master password, pengguna memasukkan password untuk dapat mengakses KeePass 2.45;

b. Key file / provider, pengguna membuat kunci akses berupa sebuah file xml 1.0. File ini harus
ada setiap kali mengakses KeePass 2.45. Sebagaimana anak kunci pada umumnya,
pengguna dapat mengambil dan mengamankan file kunci ini sehingga pengakses yang tidak

berhak tidak dapat membuka dan mengakses data dalam KeePass 2.45 tanpa adanya file

kunci yang disertakan;

c. Windows User Account, pengguna dapat mengakses KeePass 2.45 menggunakan
Windows User Account, namun harus berhati-hati apabila komputer dipinjam dan ada

pengguna komputer mengetahui Windows User Account Anda.

Pengguna dapat memilih semua, dua atau cukup satu pilihan yang diberikan. Memilih lebih dari
satu pilihan akan meningkatkan keamanan karena KeePass 2.45 akan memeriksa validitas
pilihan-pilihan tersebut. Semua pilihan harus benar agar database bisa diakses.
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Berikut adalah tampilan jendela Create Composite Master Key:

i Create Composite Master Key x| |

reate Gomposite Master

EDownload\KeePass-2 45\Database kdbx

Specify the composite master key, which will be used to encrypt the database.

A composite master key consists of one or mone of the following key sources. Al sources you specify will
be required to open the database. f you lose ane source, you will not be abls to open the database

arymare.

Master password: |uuuuouuu | EI
Repeat password: |uuuuouuu |
Estimated quality: | 51 bits 15ch.

Show expert options:
[ Keyfile / provider:  {Mong)
B Create.. [ Browss .

A ke file can be used as part of the master key: it does not store any database data. K an attacker
has access to the keyfile, it does not provide any protection.

i [ the keyfile is lost or its contents are changed, the database cannaot be opened anmymore. You
should create a backup of the key file.

More information about key files.

[ Windows user account

This source uses data of the curent Windows user account. This data does not change when the
account password changes.

i, [ the Windows user accourt is lost, i will not be enough to create a new accourt with the
same user name and password. A complete backup of the account is required. Creating and
restoring such a backup is a very complicated task. f you dont know how to do this, dont
enable this option.

Mare information about Windows user accounts.

|_He|_|:|_! | OK | | Cancel

Pengguna selanjutnya mengikuti proses membuat database (*.kdbx) dan file kunci (*.key). Berikut
adalah file database (Database.kdbx) dan key file (Database.key) yang berhasil dibuat:

D Database kdbx 14/05/2020 8:09 KDEX File 3KE
@ Dratabasekey 14/05/2020 2:09 Registration Entries 1KE

Mengingat pentingnya kedua file tersebut, pengguna diharapkan memberi perhatian lebih untuk
langkah pengamanan;

Pada panel sebelah kiri terdapat folder Database yang memuat subfolder antara lain General,
Windows, Network dan seterusnya. Pengguna dapat mengelompokkan data password yang
dimiliki berdasarkan pada kelompok-kelompok folder (group) default yang tersedia atau
menyesuaikan kebutuhan secara lebih spesifik melalui menu Group. Sebagaimana folder pada
Windows Explorer, Group dalam KeePass dapat dihapus, diedit, dibuat baru, disusun ulang dan
sebagainya.

Perhatikan bahwa tanda asterisk (tanda bintang) pada jendela database.kdbk akan muncul dan
menandakan bahwa data atau perubahan pengaturan belum disimpan sehingga pemohon perlu
menyimpan terlebih dulu melalui icon bergambar disket atau menggunakan hotkey Ctrl+S.

Untuk memulai menambahkan daftar password pilih menu Entry > Add Entry ... atau cukup klik
kanan mouse pada jendela panel sebelah kanan dan pilih Add Entry...
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@ Add Entry ﬂ
' Add Entry

Creaie d new entry.

m Advanced | Properties | Auto-Type | Histu:ur'_.'l
Tite: DJP Onine | lcon:
User name: | Fancoro |
Fassword: |uuuuuuuuuu | | e |
Repeat: |u"uuu""uuu | | &
Quality: B 100 bits | 20ch.
URL: |htt|:us:;'fdjpu:nline.pajak.go.id;’accnunt;'login |
Motes: FAplikasi Online Laporan Pajak Tahunan
[ Bopires:  |14/05/2020 0:00:00 O~ Q]
| #5Tooks | | ok || cancel |

6. Menu Tools > Options memungkinkan pengguna KeePass untuk melakukan konfigurasi yang
disesuaikan dengan kebutuhan baik pada aspek security, Policy, Interface, Integration dan
sejumlah perilaku program lainnya;

@ Options | x |

Options

Here you can configure the global KeePass program options.

T Securty E Policy E Interface ! Integration | % Advanced

[ Lock workspace after KeePass inactivity (seconds): 300 =
[ Lock wonkspace after global user inactivity (seconds): 240 o
Clipboard auto-clear time (seconds; main entry list): 12 k=
[] By default, new entries expire in the following number of days: 0 !
General A

[] Lock workspace when minimizing main window to taskbar

[ Lock workspace when minimizing main window to tray

[ Lock workspace when locking the computer or switching the user
[] Lock workspace when the computer is about to be suspended
[] Lock workspace when the remate control mode changes

[ Exit instead of locking the workspace after the specified time

[ Aways exit instead of locking the workspace

Clipboard {(Main Entry List)

Clear clipboard when closing KeePass
Do not store data in the Windows clipboard history and the cloud clipboard W

QK Cancel
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7. Pengguna dapat mencetak (print) daftar username dan password yang tersimpan dalam database
KeePass melalui menu File > Print:

@ Print IEl_

Pnnt
Print password entries.

-, Preview '_\:3 Layout
Layout
® Tabular

Arange the entries in a tabular form. Each entry will occupy approximately one line. The fields selected below wil
be prirted; auto4ype configuration is not printed.

"~ Details
Arange the entries in blocks. The fields selected below will be printed.

Fields

Title User name Password [ urRL Motes
[ Creation time [ Last modficationtime || Expiry time: Auto-Type [ Tags
[ Icon Custom string fields [] Group name [J uuip

Select Al Deselect Al

Font Options

) 82rif 1@ Sans-Serif () Moncspace Placeholders: Do not replace
Use monospace fort for passwords

] Use extra small monospace fort

Sorting

Sort entries by field:  [Mone!

Entries are sorted within their groups, i.e. the group structure is not broken up.

" | | Page Setup #& Prirt Preview Pririt... Cancel

Perlu diingat untuk mengamankan hasil print-out atau memusnahkannya segera setelah
digunakan karena daftar username dan password ditampilkan dengan jelas;

8. KeePass dapat melakukan import data dari sejumlah perangkat lunak password manager lainnya
atau dari sejumlah file berformat dan berekstensi tertentu. Sebaliknya, perangkat lunak ini juga
dapat melakukan ekspor data:

@ Import File/Data E @ Export File/Data H
ﬁ Import File/Data .y Export File/Dala
H Importan external file. n_ Export data to an external file.
Format Format
KeePass ~ KeePass
(@) KeePass KDB (1x) (@ KeePass CSV (1)
':i.;" KeePass KDBX (2x) (@J KeePass KDB (1x)
(@ KeePass KDBX {Zx) {Repair Mode) & KeePass KDEX {(2x)
| KeePass XML (1) (@) KeePass KDBX (2.34, Old Fomat)
| KeePass XML (2x) | KeePass XML (2x)
General General
_E|Generic CSV Importer = |Customizable HTML File
Password Managers [* | Transform using XSL Styleshest
1P"I.|' 4 1Password Pro CSY . Windows Favorites (Folder 'KeePass’)
ajNIe meine Passworte XML -~ Windows Favorites (Root Directony)
L5 Any Fassword CSV Browser
(7] Bitwarden JSON __|Mozila Bockmarks HTML
@, CodeWallet TXT v
File File
Files to be imported: = Export to;

Help: Configuring source applications

o ]
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HASIL UJI COBA
Melalui serangkaian ujicoba KeePass versi 2.45 ditemukan sejumlah kelebihan dan kelemahan.

A. Kelebihan:

1. Sebagai password manager yang berukuran kecil, KeePass versi portable menjadi perangkat
lunak yang praktis dan mobile;

2. Perkembangan mobile phone dan teknologi penyimpanan cloud memungkinkan penggunaan
KeePass versi mobile phone (unofficial). KeePass versi portable juga dapat disimpan pada
media penyimpanan cloud sehingga dapat digunakan selama ada akses internet selain
menggunakan media penyimpanan eksternal seperti Flash Disk;

3. Selain mengingat password utama, File database (Database.kdbx) dan file kunci
(Database.key) menjadi dua file yang menjadi kunci utama untuk mengakses daftar username
dan password, Tanpa salah satu elemen diatas akan sangat sulit bagi pihak-pihak yang tidak
berhak untuk mengakses isi database. Pengguna dapat mempertimbangkan langkah terbaik
untuk mengamankan kedua file diatas.

B. Kelemahan:

1. Lupa pada password KeePass dapat berakibat fatal karena pengembang program
menyatakan bahwa tidak ada backdoor atau sarana lain untuk mengekstrak isi database dan
mendapatkan kembali daftar username dan password;

2. Kerusakan database KeePass akibat faktor fisik atau non-fisik terkait media penyimpanan
yang memuat KeePass berakibat fatal dimana isi database tidak dapat diakses kembali;

3. KeePass tidak dilengkapi dengan kemampuan backup secara otomatis dan periodik, sehingga
pengguna perlu melakukan backup dan pengamanan data secara manual.

Contoh tampilan daftar username dan password:

@ Database kdbx* - KeePass =
File Group Entry Find View Tools  Help
J & EH |2~ Y| @ =

|5 Database Title User Mame Password URL Motes

General

'_"_‘_". Windows

L4 Metwork

% Internet

=) eMail

=% Homebanking

i~ Contoh #1  User Name Disini "+ https://keepass.info/ Tulis Catatan ..
4 Contoh #2 Michael321 Radiida https://keepass.info/help...

0 of 2 selected Ready.

Print Preview menampilkan password tanpa mask/cover:

=} Print Preview “
® = Page View o
Database Page lofl ~
Database
Tite User Name Password Notes
Cortoh #1 User Mame Disini Fasawcrdku Tulis Catatan Disini
Cortoh #2 Micha el321 12345 v
Page uf1
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Berdasarkan hasil uji coba dan mempertimbangkan manfaat-manfaat KeePass versi 2.45 diatas, maka
KeePass versi 2.45 dinyatakan cukup layak untuk digunakan sebagai personal password manager
bagi para pegawai di lingkungan Dinas Penanaman Modal dan Pelayanan Terpadu Satu Pintu
Kabupaten Madiun untuk melancarkan pekerjaan yang terkait dengan login beragam aplikasi yang

digunakan.



